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Getting Started 

Making a Backup Copy 

The KidsTime® n disk provided in this package could be used 
as your working disk. However, we strongly urge all owners of 
KidsTime n to make a copy ofthe original disk to use as a work
ing disk and archive the original disk. This is especially impor
tant if young children will be using the disk. You can backup the 
KidsTime n disk with any disk copy utility or with the Finder. 
Please make a backup copy of your disk before doing anything 
else. Although we do provide replacement disks, they are not free 
after the 90-day warranty period nor if the problem could have 
been avoided by making a backup copy. 

Unauthorized duplication and distribution of 
KidsTime n is theft. Since KidsTime n is intended 
for children, we strongly urge you to consider the 
effects software piracy may have upon a child. Our 
ability to continue to provide quality software at 
reasonable prices is dependent upon your respect 
of the copyright and property laws which protect 
Great Wave Software and its products. 

Owner Registration Card 
Sending in the owner registration card which is included with 
KidsTime n is very important. Once the card is received by 
Great Wave Software, you will be on a list of software owners that 
will receive newletters and update information. Look for your 
KidsTime n owner registration card, fill it out, and mail it 
today. 
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Children and Apple IIGS Safety 
The Apple nGS is a good machine and is great for children be
cause it is easy to use and less prone to damage than many other 
computers. But, like all machines, tbere are ways to destroy it. A 
young child should not be left unattended while playing on the 
Apple lIGS. Care should be taken that the mouse is used gently. 
Children are easily excited while playing a game and the mouse 
should not be banged upon or banged on a desk top. A mouse pad 
is recommended to extend the life of your mouse. Small objects 
such as paper clips and pencils should be put away so they won't 
be pushed into the disk drive slots. Don't allow a child to eat or 
drink near the Apple lIGS or the keyboard. Spilling a drink on 
the keyboard can destroy it. Make sure the child's hands are 
washed before using the keyboard or the mouse. It is always 
better to be safe than sorry. 

KT Preferences-Unlocking Save Options 
KidsTime n comes with a safety feature called Preferences 
built into it. The file KT.PREF must be on the disk-in the 
SYSTEM FOLDER-for the programs to function. It allows each 
of the programs to be customized and locked to avoid accidental 
changes to the data files. 

Preferences can be accessed within any ofthe 3 programs. To 
get to it, pull down the Apple menu and select the About ... 
option. When the box comes up, press the command key (open 
Apple key) and the option key and hold them down while click
ing with the mouse on the name and address of the publisher 
(Great Wave Software). A configuration screen will appear to 
allow the options to be set for a particular program. 

Each program has its own configuration screen with different 
options appropriate for that program. They allow you to adjust 
the way menu options are set when the program first begins. 

You may wish to physically lock the disk by sliding open the little 
window in the upper right-hand corner of the disk (so you can see 
through it). This way the child will not be able to erase the disk 
or throw things into the trash. 



Getting Started 4 

Getting Acquainted with the Apple IIGS 

Overview 
This section will help you and the child become more familiar 
with the terms used while working with the Apple IIGS. 

Using the Mouse 
Moving the mouse around on a flat surface will move the pointer 
on the screen. If the mouse is moved left, the pointer will move 
left. Move the mouse to move the pointer to the desired position 
on the screen. Point at objects by placing the mouse cursor 
directly on top of them. 

Click Once 
When asked to click once on an object, point at it with the mouse 
and push the button on the mouse once with a light touch. 

Double Click 
When asked to double click on an object, point at it with the 
mouse and push the button on the mouse twice in quick succes
sion. 

Drag 
When asked to drag an item, point at it with the mouse, push the 
mouse button and hold it down while moving the mouse and 
'dragging' the item to the appropriate position. 

Repositioning Windows 
Most Apple nGS windows can be repositioned by dragging their 
title bars (the portion of the window with the title and close box). 
We have found that children often drag the KidsTime n win
dows unintentionally and get frustrated when they can't put a 
window back where it belongs. Thus, the windows in 
KidsTime n are not moveable. 

Scroll Bars 
Many Apple nGS applications use scrolls bars at one point or 
another. These are the horizontal or vertical bars with arrows at 
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either end, gray in the middle, and a white box to indicate their 
current setting. There are three ways to change the setting of a 
scroll bar. To change it by small amounts, click in the arrows. To 
change it by a somewhat larger amount click in the gray areas, 
sometimes referred to as paging since in many word processors 
this will scroll by one screenfull. (Clicking and holding will result 
in successive changes until you release the button.) Finally, the 
indicator box can be picked up and dragged to the desired destina
tion. 

Selecting a Menu Option 
When asked to select a menu option, move the mouse to the menu 
label and push the button on the mouse. While holding the mouse 
down, move the pointer downward to highlight the menu options. 
Menu options not available at a given time will be dimmed and 
will not be highligbted when the mouse moves over them. To 
select an available option, move the mouse to the desired option, 
which will be highlighted, and release the mouse. 

Quit 
When ready to end a game or move on to a different game, select 
Quit in the File menu. This will stop the current game, clear the 
screen, and return to the Finder. 

Control of Volume 
To change the volume level of the sound coming from the 
Apple IIGS, use the Control Panel. The Control Panel is 
accessed by holding down the Open-Apple and Control keys at the 
same time and then pressing the Escape key. See your Apple 
nGS manual for more information about the control panel. The 
exception to this is KidsNotes. KidsNotes has a volume control 
on the program screen. If you have a special sound card such as a 
stereo card, you may need to set the Sound Card option in each 
program's preference window. 
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Highlighting 
When told to highlight an item, move the mouse to the beginning 
of the item to be highlighted. Press down the mouse button and 
hold it down while dragging the mouse to the end of the item you 
are highlighting. As the mouse is pulled along, the selected item 
will be highlighted in reverse. 

Safety with the Apple IIGS 
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Taking safety precautions with young children using the Apple 
IIGS cannot be overemphasized. There are many ways that harm 
can be done without proper supervision. Care should be taken 
with the mouse. Remember: don't allow a child to eat or drink 
near the Apple IIGS. Keep small objects out of reach ofthe child 
so that they are not put into the disk drive slots on the front of 
the Apple HGS. This will help ensure many hours of enjoyment. 

Using a Hard Disk or Special SYSTEM Folder 
If you use KidsTime II with a Hard Disk, or if you use a different 
SYSTEM folder, you need to keep some files together. First, the 
KT.PREF file I!l.l.l..Ot be in the SYSTEM folder. Copy it from the 
SYSTEM folder on the KidsTime n disk to the other SYSTEM 
folder. Also, all of the files on the disk excent the files in the SYS
TEM folder must be copied onto the new di;k if you want all three 
programs to work. If you want to make a working copy of the disk 
that just has 1 or 2 of the programs on it, use the following as a 
guide to make sure you have all the files you need. 

All three programs require that both the WAVE.BANK file and 
the KT.PREF be in the SYSTEM folder. 
ABKey also requires: 

ABFONTS 
ABVOICE 

KidsN otes also requires: 
The MUSIC Folder 

Dot-to-Dot also requires: 
The PUZZLES Folder 

Introduction 

Educational activites, including computer software, are commonly 
expected to exhibit immediate results in skill improvement (such 
as math, reading, or spelling). Since preschool educational 
software is not usually of the "specific skill development" type, an 
overview of the educational aspects of such software follows. This 
overview provides some ofthe basics ofthe value of play. Play is 
such an important aspect of a young child's life that this informa
tion should be beneficial to both adult and child. 

Value of Play 
Play has traditionally been undervalued. It has been said that 
play does little more than reduce tension and anxiety. Attitudes 
have changed lately towards the significance of play and games. 
Play behavior, as argued by some researchers, has significant 
effects on the development ofthe child. 

Areas of child development which are affected by play include 
physical, social, intellectual, personality, and emotional develop
ment. Play is important in developing self-esteem, creativity, 
problem-solving strategies, and the ability to cope in an accept
able manner in society. What looks like idle or aimless play is the 
way in which children discover the world around them and how to 
deal with it. 

Children develop their characters through play. Children need 
many opportunities to make decisions and choices when they are 
young. Play often provides them with these opportunities. 

Skills which are often taken for granted by adults are tasks young 
children must practice and perfect. It takes hours and hours of 
play to learn new words, experiment with interactions, test rules, 
practice skills and solve problems. For instance, play can allow 
the child to develop a larger vocabulary and learn new words in 
new combinations. Children repeat an activity until it is mas
tered. Then they can progress to a more complex level. Through 
this process they progress at their own speed and are able to gain 
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competence in the basic skills. Jean Piaget, a noted researcher in 
child development, stated that when children discover something 
for themselves, it will often remain with them. Children often 
master skills by working things through for themselves. Play 
offers them this opportunity. 

Social Development 
Through playa child learns and is better able to understand the 
surrounding world. Play provides an opportunity to express feel
ings. By communicating with others, a child is able to grow 
socially. 

Physical Development 
Play can help develop fine and gross motor skills. Children 
develop gross motor skills by engaging in such activities as 
outside play, running, and playing with balls. Small motor skills 
can be developed through play with objects such as pencils, clay, 
blocks or keyboard manipulation. 

Behavior 
Children need to develop the ability to play by themselves as well 
as with other children. Through solitary play, children can 
lengthen their attention spans and improve the ability to think 
for themselves. Children also develop skills and abilities when 
they play with other children. Small groups of young children are 
willing to repeat things many times and still remain enthusiastic. 
This repetitiou is essential for certain types oflearning, even 
though it may seem boring to older and more competent children. 

Involvement in Children's Play 
Children develop skills and capabilites very rapidly during the 
early years of life. Play facilitates their development during this 
time period. One important factor in a child's life is adult interac
tion. 

Learning from adults does not have to occur solely in an "educa
tional" setting. A child learns a great deal from the adults in his 
life before ever entering a school setting. The home environment 
and the aVailability of play can affect how a child learns. 
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Adults are not always aware of their influence on children. 
Adults can be a positive influence by playing with children or by 
simply spending time observing their play. By watching a child at 
play, adults communicate confidence in and approval ofthe child's 
ability. By supporting children in their play, adults assist them 
in their understanding of the world around them. 

Educational Basics of the Programs 
All KidsTime IT programs have the general benefits of play as 
described in the preceding section. By providing fun and reward
ing activites, these programs encourage creative play in a learn
ing environment. Working with a computer is a valuable educa
tional experience for most children. The following are some 
educational skills which can be developed using the programs. 

KidsTime IT can help the child learn numbers and letters, basic 
musical concepts, and eye/hand coordination. The child can learn 
number and letter sequencing with Dot-to-Dot. 

As the child becomes more familiar with the alphabet and the 
Apple nGS keyboard they will enjoy trying ABKey. ABKey can 
help the child learn to identifY sounds ofletters and beginning 
sounds of words. 

KidsNotes can help develop an interest in music while teaching 
musical concepts such as note names and durations, the basics of 
key and time signatures, and the correlation between notes on the 
piano keyboard and notes on the staff. 

Hints for Different Age Groups 
Children develop at different rates at various stages in their lives. 
As they learn new skills, they may need to review old skills they 
have previously mastered. KidsTime II includes many different 
skill levels and activities. Although each child is unique in his or 
her patterns oflearning, the following are some ideas and hints 
for ways to use KidsTime IT with children of different ages. 
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Hints for Very Young Children 
Very young children have the same fascination for computers as 
do the rest of us. The very young child would enjoy two 
KidsTime II programs in particular. If you set the preferences 
in ABKey to Learning, then each time a child presses (purposely 
or accidently) a key on the keyboard, the letter or picture for that 
letter appears on the screen. KidsNotes can also provide great 
experiences if you set the preferences so that Record Notes is off. 
The child can then "play" the keyboard for any length of time 
without running out of room. The child can also make the com
puter play songs simply by pressing the spacebar. Both of these 
programs create exciting computer responses to the actions of the 
very young child. At the same time, the child is being introduced 
to music and to the alphabef. 

Hints for Young Children 
Young children can generally have success with Dot-to-Dot and 
ABKey. Beginning with Dot-to-Dot, children can simply move 
the mouse oveT the dots without having to ever click the mouse. 
Sound and completed pictures give a great reward for this pro
gram. In ABKey, a child can match the letters on the screen 
with the letters on the keyboard. If a wrong choice is made, a low 
tone is sounded. The letter remains on the screen until the 
correct key is pressed, making this a very unpressured setting for 
this alphabetlkeyboard activity. 

Hints for Older Children 
There are often children using the computer of varying ages and 
skill levels. Older children can use KidsNotes to develop more 
advanced skills. KidsNotes also provides for development of 
creative skills. This basic music introductory program allows 
children to compose melodies, listen to them, edit them, and save 
the music. They can explore the different musical concepts 
included as they create their own music. Older children may also 
enjoy creating Dot-to-Dot puzzles for themselves, their friends, 
or younger children. 

Overview 
Letters and/or pictures will appear on the screen. The name of 
the letter will be spoken when the matching letter or beginning 
letter of the picture's word is selected. 

When ABKey is first opened, one upper case letter will appear 
centered on the screen in large print. When the matching letter is 
pressed on the Apple nGS keyboard or on the alphabet bar at the 
bottom of the screen, the computer will say the name of the letter. 
The letter will then be replaced by another upper case letter. If 
an incorrect key is pressed, a tone will be heard. 

Letters and Pictures 
There are four different options with the letters and pictures. 
Upper Case letters, Lower Case letters, Easy pictures, and 
Hard pictures. Upper Case letters contain only upper case or 
capital letters. Lower Case letters contain only lower case or 
small letters. Easy pictures are pictures in which the beginning 
letter of the picture should be easy to figure out. Hard pictures 
are pictures in which the beginning letter of the picture may be 
harder to figure out. 

To Change or Add Letters or Pictures 
To change or add to what appears on the screen, use the Letters 
menu. The options are Upper Case letters, Lower Case 
letters, Easy pictures, and Hard pictures. Pull down the 
menu and select the desired option. You can select one, two, 
three, or all four options at the same time. There will be a check 
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mark to the left of each option that is selected. The type of object 
that appears on the screen is chosen at random from all options 
that are currently selected, so by checking both upper case letters 
and lower case letters, a mix of the two will be shown. To re
move an option, select it again and the check mark will disap
pear. The option will be temporarily removed from use until it is 
selected again. 

Levels of Difficulty 
To make the game more challenging there are different levels of 
difficulty. There are six options: 1 at a time, 2 at a time, Slow, 
Medium, Fast, and Learning. Only one option can be played at 
a time. 

1 at a time displays one letter or picture centered on the screen 
and in large print. When the correct letter is pressed, the com
puter will speak the letter. When the correct beginning letter of 
the picture is pressed, the word will also be printed below the 
picture. 

2 at a time displays two letters and/or pictures centered on the 
screen and in large print. When the correct letter is pressed, the 
computer will speak the letter. When the correct beginning letter 
of either picture is pressed, the word will also be printed below 
the picture. 

Slow displays letters and/or pictures randomly anywhere on the 
screen. A new one will appear every 10 seconds or after the 
correct key is pressed, whichever occurs first. The letters and 
pictures will be in small print. The word will no longer be printed 
below the picture when the correct beginning letter is pressed. 
The computer will not speak the letter. 

Medium displays letters and/or pictures randomly every 5 
seconds. The computer will not speak the letter. 

Fast displays letters and/or pictures randomly every 2 seconds. 
The computer will not speak the letter. 

ABKey 13 

Learning allows the child to press a key or click on a letter and 
have the corresponding letter or picture appear on the screen. It 
will randomly choose between the options which are selected in 
the Letters menu. 

To Change Level of Difficulty 
To change the level of difficulty use the Level menu. Pull down 
the Level menu and select the desired level. 

To Change the Sound 
By using the Options menu, the voice and the sound can be 
turned on and off. 

To Change the Print under the Pictures 
The Options menu allows control over whether the print below 
the pictures is in upper case letters or in lower case letters. To 
display words in lower case letters, select Lower Case Words 
until no check mark appears beside it. 

Menus 

File 
New Starts a new game at the same level of difficulty. 

Quit Ends ABKey. 

Letters 
UpperCase 

Upper case letters will be included in the game. 

Lower Case 
Lower case letters will be included in the game. 

Easy Pictures 
Pictures with beginning letters that should be easy to 
figure out will be included in the game. 

Hard Pictures 
Pictures with beginning letters that may be harder to 
figure out will be included in the game. 
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Level 
1 at a time 

2 at a time 

Slow 

Medium 

Fast 

These options are used to select the level 
of difficulty. See pages 12-13 for complete 
descriptions. 

Learning 

Options 
Turn Sound On / Off 

This allows the sound to be turned on and off. 

Turn Voice On/Off 
This allows the voice to be turned on and off. 

Lower Case Words 
When this option is in effect (indicated by a check mark 
in front of it), the print under the pictures will appear in 
lower case letters. When this option is not in effect 
(indicated by no check mark in front of it), the print 
under the pictures will appear in upper case letters. 

Hide / Show Alphabet 
This allows the alphabet bar at the bottom of the screen 
to be hidden or shown. If it is shown, the child can click 
on a letter with the mouse to select it. 

Suggestions for Further Learning 
Learning the alphabet is a basic requirement in our society. The 
child may be able to sing the ABC song, but may not recognize the 
letters. As the child finds the matching letter on the keyboard, 
the computer will say the name of the letter so the. child can begin 
to recognize the letters and figure out what the name of the letter 
is. When the child starts using the pictures, they will begin to see 
what the words look like and begin to recognize the letters in a 
different context as well. 

, 
f 
I , 

j 

ABKey 

ABKey will also help the child become familiar with the 
Apple IIGS keyboard and the position ofthe letters. 
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Mter the child gets a predetermined number ofright answers, the 
computer will play'the ABC song. While the song is playing, 
blocks containing either letters or the pictures will appear on the 
screen. The blocks will always be in alphabetical order. Before 
pushing the mouse to continue, you might want to have the child 
sing the ABC song while looking at the letters. Help the child 
realize that the pictures are also in alphabetical order. Have the 
child go through the alphabet and find the pictures that start 
with each letter. 

A child doesn't need to know the alphabet to try this game. To 
begin, select just upper case letters since they match the letters 
on the keyboard. Have the child do 1 at a time so they won't be 
overwhelmed by a screen full of letters. Have the child hunt for 
the letter that matches and press the matching key. The child 
can tell by the sound ifthey are wrong and you can tell by the 
look on their face if they are right. 

As the child masters the first level, have the child try 2 at a time, 
still with just upper case letters. When the child feels comfortable 
with upper case letters, add the lower case letters also. When the 
child is ready to Jearn more about sounds, add the Easy pictures 
and have the child say the word slowly and sound out the begin
ning letter. As the child grows and learns, the Hard pictures 
can be added to increase the difficulty. To make it even more 
challenging, move the child through the Slow, Medium and Fast 
levels. At any point, use the Learning option to allow the child 
to explore the alpbabet. 
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Dot-to-Dot 

Overview 
Dots will appear on the screen. Move the mouse around to 
connect the dots in sequence. When the last dot is connected, the 
details will be filled in with a picture. 

When the dots appear on the screen, move the mouse so that the 
pointer (in the shape of a plus sign) passes over the dot next to 
the number. There is no need to click on the mouse. As the dot is 
connected a sound will be heard. After several seconds the next 
dot will flash if you have not selected it. The delay before the 
next dot starts to flash is set in the preferences file (see page 3). 
If a number is selected out of sequence, nothing happens. When 
the last number has been connected, the picture will be filled in. 

To continue to the next puzzle, click the mouse button once. 

Changing Dot Labels 
To change the labels next to the dots use the Labels menu. The 
options are numbers, upper case letters, and lower case letters. 

Changing Puzzles 
To change to a different puzzle in the current file, use the 
Puzzles menu. Select the desired puzzle and it will appear on 
the screen, ready for play. 

Turning the Sound On and Ofr 
The sound can be turned on and offby using the Options menu. 

Changing the Label Size 
The labels next to the dots can be changed in size by using the 
Options menu. The label size can be small, medium, or large. 
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Making New Puzzles 
To make your own puzzles select Make New Puzzle from the 
Edit menu. You can also edit the current puzzle by selecting 
Edit This Puzzle from the Edit menu. In order to save a new 
puzzle or to save changes to an existing puzzle, the Save option 
must be selected in the preference screen for Dot-to-Dot (see 
page 2 for further instructions). 

Using a Paint File with a Puzzle 
While editing or creating a puzzle, you can load a new picture 
from a Paint file by clicking on the Picture button. This will 
allow you to select a Paint file created with a paint program such 
as 8/16 Paint by Baudville. The selected Paint file will be used 
for the puzzle. It will replace any picture already used by the 
puzzle. The paint files and the Dot-to-Dot data files must be kept 
in the folder on the disk named PUZZLES. Place any paint files 
you create in that folder if you want to use them with Dot-to-Dot. 

Dot-to-Dot F':uzz 1 e Editor 

+ 

[picture] 1~IClI+ 1091.1'1 Locked ( OK ](Cance 1] 

Dot-to-Dot Puzzle Editor 

Dot-ro-Dot 19 

At the bottom ofthe Dot-to-Dot Puzzle Editor window 
is a palette of tools. Click on the picture of a tool to 

there 
select 

it. 

Positioning the Picture 
I:ii'i'iiI Select the hand tool to drag the picture around on the Ifn screen to position it. Normally, the dots move along with 

the picture. If you press and hold the Option key before 
you start to drag the picture, only the picture will move and the 
dots will stay in the same position. 

Positioning Dots 
Select the tool that looks like a plus sign to add dots to the 

1 + 1 puzzle. Each time you click, a new dot is added to the end 
ofthe puzzle. While you hold the button down you can 

move the mouse to position the new dot. 

Changing Dot Locations 
I ,:<:.1 Select the mover tool to reposition dots. To move a dot, 
'W click on it and then move the mouse while holding the 

button down. When you release the button, the dot stays 
at its new position. 

Removing Dots 
r::::iI Select the eraser tool to remove dots. To remove a dot, 
~ click on it. The dot about to be removed will be highlighted 

while the button is pressed. 

Inserting Dots 
rJil Select the insertion tool to insert new dots between dots t£J that are already on the screen. Click on an existing dot 

with this tool to insert a new dot between a dot and the im
mediately following dot. Then move the mouse while holding the 
button down to position the new dot. 

The picture can be temporarily hidden from view at any time by 
pressing the space bar. Press the space bar again to show the 
picture. 
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Undoing Changes 
You can undo most changes immediately after they are made by 
selecting Undo from the Edit menu. This will only undo the 
most recent change. 

Undoing All Changes 
If you want to undo all changes to a puzzle, click on the Cancel 
button. This will remove all changes made since Edit This 
Puzzle was selected from the Edit menu. 

Saving Changes 
lfyou click on the OK button then you will return to the regular 
Dot-to-Dot game with the edited puzzle selected. If saving is 
enabled in the preference screen (see page 3 for further instruc
tions), then you will be able to save the changes when the OK 
button is selected. If saving is not enabled, then the changes you 
have made will be not saved and, after selecting the OK button 
and solving the puzzle, the changes will no longer be present. 

Menus 

File 
Quit Ends Dot-to-Dot. 

Edit 
Undo 

Undoes last change in the Puzzle Editor Screen. 

Make New Puzzle 
Opens the Puzzle Editor Screen with a blank screen to 
allow making new puzzles. 

Edit This Puzzle 
Opens the Puzzle Editor Screen with the current 
puzzle loaded to allow changes to the current puzzle. 

Remove This Puzzle 
Removes the puzzle from the disk. Does not remove any 
associated Paint files. 
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Puzzles 
Contains a list of the names of the puzzles currently avaliable. 
The title ofthe puzzle showing on the screen will have a check in 
front of it. Puzzles must all be kept in the folder named 
PUZZLES. Do not move them. 

Labels 
Numbers 

All the dots will appear with numbers for labels. 

Upper case Letters 
All the dots will appear with upper case letters for labels. 
Ifthere are more than 26 dots, double letters will be used 
(i.e. AA BB CC ... ), then triple letters, and so on. 

Lower case Letters 
All the dots will appear with lower case letters for labels. 
Ifthere are more than 26 dots, double letters will be used 
(i.e. aa bb cc ... ), then triple letters, and so on. 

Options 
Turn Sound On / Of( 

This allows the sound to be turned on and off. 

Small Labels 
Medium Labels 
Large Labels 

The labels by the dots will display in the selected size. 

Suggestions for Further Learning 
Numbers and letters are the basic elements of our communi
cation. Children need to learn the alphabet before they can learn 
to read and write. Numbers need to be learned before math can 
be taught. Repetitive play can be a useful and a fun way to teach 
children numbers and letters. By getting the numbers or letters 
in the right order, the child sees the puzzle being built, hears the 
sounds get higher and higher as the child connects the dots, and 
watches the whole picture appear when the puzzle is complete. 
This reinforcement helps to keep the child trying. Dot-oo-Dot 
also helps develop hand/eye coordination. 
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For a child just learning to do dot-to-dot puzzles, start with the 
number labels in the medium or large size print. The child may 
be able to count to 10, but might not know what the numbers look 
like. It might help the child to point out that the numbers on the 
Apple IIGS keyboard are in numerical order. The child can look 
at the keyboard to see what number comes next until the correct 
order is learned. Even if they can't count, they can move the 
pointer around trying the various dots until the correct one is 
found, or can wait until the next dot begins flashing. The satis
faction of getting it right reinforces the learning. 

When the child is ready to go to the alphabet, the labels can easily 
be changed. Start with the upper case letters first since they are 
usually learned first. If the child needs help deciding the order of 
the letters, the alphabet could be written on a piece of paper in 
large print for the child and placed next to the keyboard. Singing 
the ABCs while doing the puzzle might also help the child remem
ber what comes next. The child will soon learn to solve the prob
lem of what letter comes next without needing to ask an adult for 
help. 

The most difficult level is the lower case letters, since they are 
usually learned last and are not represented on the Apple IIGS 
keyboard. A sheet of paper with the lower case letters written on 
it may be useful at first. 

Doing the puzzles over and over with different labels will give 
children the repetition they need to learn and remember the 
correct order of the numbers and letters. They will enjoy doing it 
without realizing they are learning in the process. 

The Dot-to-Dot program automatically selects the files in the 
PUZZLES folder when it starts up. Altering the puzzles to suit 
the child's abilities can easily be accomplished with the Make 
New Puzzle and Edit This Puzzle options. Making your own 
puzzles is fun and easy and can be quite rewarding. 

KidsN otes'" 

Overview 
Simple melodies can be created easily by clicking on the piano 
keyboard on the screen or by pressing the keys on the Apple IIGS 
keyboard. While playing the keyboard, the notes are recorded on 
the staff below. To hear the song, click on Play. 
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KidsNotes Screen 

1. Keyboard 5. Note Lengths 
2. TempoNolume Controls 6. Rest Button 
3. Key Signatures 7. Timed Entry 
4. Time Signatures 8. Song List 
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To Playa Song 
The disk includes several songs familiar to children. Use the 
scroll bar to see all the song titles. To play one of these, click once 
on the desired title. The notes will appear on the staff and the 
song will play. While it is playing, the notes on the staff and the 
notes on the screen keyboard will be highlighted. If Record 
Notes is not checked, then pressing the space bar will play the 
next song on the list. 

To Change the Tempo 
To change the speed of a song, use the Tempo scroll bar in the 
upper left corner. Either click on the arrows, the gray region, or 
drag the square. Moving to the right will play the music faster. 
Moving to the left will play th"e music slower. 

To Change the Volu.me 
To change the volume (soMoud) of a song, use the Volume scroll 
bar in the upper left corner. Either click on the arrows, the gray 
region, or drag the square. Moving to the right will play the 
music louder. Moving to the left will play the music softer. 

To Choose a Key Signature 
The key signature determines how many sharps or flats there are. 
To select a key signautre, click in the circle to the left of it. The 
key signature will appear on the staff below. 

To Choose a Time Signatu.re 
The time signatures included in KidsTime II dictate how many 
quarter notes there will be in a measure. To select one, click in 
the circle to the left of the desired time signature. The selected 
time signature will appear on the staff below. 

To Choose Note Length 
The length of a note determines its relative duration when it is 
played. To choose the length ofthe note, use the boxes in the 
upper right corner. Click in the box ofthe length desired. If you 
click on the picture of the stopwatch, the length of the note will 
depend upon how long the key is held down. 

KidsNotes 

To Choose Notes 
To choose the note pitch, click on the piano keys on the screen 
keyboard. The notes being played will be heard. If Record 
Notes is checked, the notes will be inserted in the score at the 
insertion point as they are played. 

To Insert a Rest 
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To insert a rest, where no note is played, check Record Notes. 
Choose the length ofthe rest with the note length box. The value 
of the rest will appear in the Rest button near the Play button. 
Clicking on the Rest button will insert a rest at the insertion 
point. 

To Create a New Song 
Click on Record Notes until there is an X in the box at the left of 
it or select New Song from the File Menu. First choose a key sig
nature, then choose a time signature. Click on the keys to play 
the song while using the note length boxes to determine the 
varying note lengths. The key played will be highlighted while 
the notes appear on the staff below at the vertical bar marking 
the insertion point. If you click on the stopwatch the computer 
will time how long you hold down the notes. If you start with an 
existing sane you can use the Save As option to save the changed 
song with a new name. 

Editing a Song 
Notes can be selected with the mouse and deleted with the 
Backspace key. Selected notes will also be replaced when new 
notes are played or rests are inserted. 

To Playa New Song 
To hear the whole song, click on Play. 

To Save 
Save will only work if the Save option has been selected in the 
preferences screen (see page to 2 for further instructions). To 
save a change or save a new song use the File menu. Select Save 
and the song will be saved and added to the list of songs which 
appear in the scroll bar on the screen. If it hasn't yet been 
named, you will be asked to name it first. 
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Using the Apple IIGS Keyboard 
The notes can also be played from the Apple nGS keyboard. The 
bottom row of keys corresponds to a portion of the white keys on 
the piano keyboard. The keys in the next row up correspond to 
the black keys. Pressing the shift key will move the pitch up an 
octave. See the diagram below. 

Apple IIGS Keyboard Pitches 

Menus 

File 
New Song 

This will clear the staff so a new song can be created. 

Save This will only work ifthe Save option has been selected 
in the preferences screen (see page 3 for further 
instructions). It will save changes to the song or ask for 
a name if it is a new song and then add it to the title 
scroll bar on the screen. If you are editing an existing 
song, this will replace the old version of the song with 
the current notes. 

Save As 

Quit 

This will only work if the Save option has been selected 
in the preferences screen (see page 3 for further 
instructions). It will save changes to the song and will 
always ask for a new name. Use this option to save 
a changed version of a song with a new name. 

Ends KidsNotes. 
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Options 
Hide Note Names 

This will make the names ofthe notes under the keys no 
longer visible. 

Suggestions for Further Learning 
Children love to play instruments and make music. KidsNotes 
gives tbem the opportunity to play and see the notes appear on 
the staff. As the young child begins to use the program it will just 
be random playing on the keys. This will develop over time to 
trying to imitate the songs the child enjoys singing. KidsNotes 
may help the child develop a few basic musical skills. The child 
may learn note names, note and rest durations, and basic key and 
time signatures. 

You may want to use a music book with simple children's songs. 
The songs can be entered in KidsNotes with the help ofthe 
diagrams on the back cover. The diagrams show where the notes 
on the staff are located on the piano keyboard for the three simple 
key signatures available in KidsNotes. 

Young children really enjoy listening to their favorite songs by 
pressing the space bar when Record Notes is not selected. 

To learn the difference between note lengths and their resulting 
rhythms, have the child experiment to see the difference. Play 
the song with all the notes being the same length and ask the 
child what is different. Change the notes to different note lengths 
and notice the difference in the playback. 

Notes to the Musically Unsure 

Note Pitches 
Musical notes have the names of A through G. As notes increase 
stepwise in pitch (become higher), their names increase until they 
reach G. Mter G they start over again at A, but this time with a 
pitch that is twice as high as that ofthe previous A. This dou
bling in pitch is referred to as an octave. There are eight notes in 
an octave. The white keys on the piano keyboard are configured 
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to have a one to one correspondence with the positions on the staff 
in the simplest key signature, referred to as the key of C. To hear 
this, begin playing on a note labelled C and play the white keys in 
succession to the next C. You have just played one octave of the C 
scale and, if you choose the key signature without any sharps or 
flats, you will see the one-to-one correspondence between the 
white keys and the notes on the staff. While looking at the staff, 
notice that the higher the note on the staff the higher the pitch. 
The staff is not big enough to show all the keys of the piano. 
Some of the higher notes will be shown above it and some of the 
lower notes will be shown below it. 

Some of the notes in any scale are a "whole step" apart, others are 
a ''half step" apart. By playing the scale and listening you should 
be able to hear which pitch steps are larger and which are 
smaller. The pitches that are a half step apart are immediately 
adjacent on the piano keyboard, while those a whole step apart 
have an intervening key. (Examples: from B to C is a half step, as 
is C to C~, while C to D is a whole step.) The black key plays a 
pitch a half step_away from either of the adjacent white keys. 

A black key receives its name from either of its adjacent white 
keys plus the addition of a ~ or ~ (sharp or flat) sign, as follows. 
There are two ways this is notated. In the first, we refer to the 
white key below it in pitch and say that this one is one-half step 
higher, or "sharper." It is notated with the lower pitch name 
followed by a ~ (sharp) sign. The other way is to refer to the white 
key above it in pitch and say that this one is one-half step lower, 
or "flatter." It is notated with the higher pitch name followed by 
a ~ (flat) sign. In musical notation, these signs precede the musi
cal note on the staff. Press some black keys to see how they are 
displayed. Pressing the sharp and flat key signatures will alter 
how they are displayed. 

Key Signature 
Many songs make extensive use ofthe black keys, so to simplifY 
notation the idea of key signatures was developed. For example, 
with one sharp in the key signature (positioned on the F) all 
occurrences of the note F are implied to have a sharp in front of 
them, even though it is not written. If the composer really 
wanted an F and not an F* in that spot, then the note is preceded 
by a natural sign q to denote this temporary return to the F 
natural. 
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To help with the understanding of how the notes of the piano 
correspond with the notes on the staff the three diagrams on page 
30 show where the notes played on the piano keyboard will 
appear on the staff. They show the differ-ence between the three 
key signatures available in KidsNotes. 

Note Lengths 
The way a note is written on the stfu'f determines how long it is 
played. Rests are treated in the same way. In KidsNotes there 
are whole notes, half notes, quarter notes, eighth notes, and 
sixteenth notes. A whole note lasts the same length of time as 16 
sixteenth notes. A half note is half the length of a whole note, a 
quarter note one fourth, and so on. All these note lengths can be 
'dotted' in KidsTllne except for the whole note. To dot a note 
means to increase the length of the note by half again the usual 
length of it. It is shown by putting a dot after the note. This 
means that if a quarter note has a dot after it, it now should be 
played as if it were a quarter and an eighth note combined. 
Dotted notes allow for more diverse and interesting rhythms. 

A diagram showing the note lengths and how they relate to each 
other is on the back cover. 

Measure Markings 
The beginning and the ending of a measure are marked with a 
vertical line. The number of notes that can correctly fit in a 
measure depends on the time signature and note durations. 

Time Signature 
The top number in the time signature tells how many beats 
there are per measure. The bottom number tells which note 
length will get the beat. For example: in 3/4 time the quarter 
note gets the beat and there are 3 beats (quarter notes) per 
measure (or 6 eighth notes, 12 sixteenth notes, and so on). In 6/8 
time the eighth note gets the beat and there are six beats (eighth 
notes) per measure. If a note will not fit in the rest of a measure, 
it is broken up into smaller parts and tied together over the 
measure line with arcs. Since KidsNotes is geared to beginning 
musicians, only the simplest time signatures are included. 


